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License: This is an open access protocol distributed under the terms of the Creative Commons Attribution License, which

permits unrestricted use, distribution, and reproduction in any medium, provided the original author and source are credited

Protocol status: Working
We use this protocol and it's working

Created: February 20, 2024
Last Modified: March 21, 2024
Protocol Integer ID: 95480

Keywords: invertebrates, timelapse, low cost, animal behavior, lapse imaging system for hydra hydra, freshwater cnidarian
polyp, hydra hydra, genus of freshwater cnidarian polyp, hydra, other small invertebrate, lapse imaging system, organism, lapse
imaging, cell phone camera, phototaxi, ideal model organisms for college, imaging chamber, ideal model organism, biology,
regeneration experiment, consuming live prey, tissue, importing cell phone video, inexpensive plastic lens, high school biology
lab, tissue piece, live prey, tissue organization, cell, lapse imaging of the behavior

Abstract

Hydra is a genus of freshwater cnidarian polyp known for their ability to regenerate their entire body from tissue
pieces. Despite their simple body plan and tissue organization, Hydra is capable of complex behaviors, including
capturing and consuming live prey, somersaulting locomotion, and phototaxis. Hydra make ideal model organisms
for college and high school biology labs because they are easy to grow in large numbers and regeneration
experiments can be carried out with minimal resources. The inexpensive setup described here allows time-lapse
imaging of the behavior of Hydra, or other small invertebrates, with a cell phone camera. An imaging chamber is
constructed out of cardboard. The sample is illuminated by a USB-powered LED panel and magnified by an
inexpensive plastic lens. We also provide example movies and instructions for importing cell phone videos into
Imaged.

Image Attribution
Callen Hyland

Guidelines

For general guidelines for maintaining, working with and disposing of Hydra, please see Low Cost Methods for
Hydra Care.
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Materials

Materials for making the imaging chamber:

= Imaging chamber pattern files (download from Thingiverse)
= Corrugated cardboard, 2 or 3 mm thick

m Scissors, boxcutter, laser cutter, or Cricut cutter

= Glue or double-sided tape

= A6 LED light panel with micro USB cable (example)

m USB wall adaptor

= 25 mm plastic lenses (example)

= Translucent vinyl sheet (example)

= QOptional: rubber bumpers (example)

Materials for behavioral imaging:
= Hydra and Hydra medium

= Glass Pasteur pipette and bulb
= Plastic or glass petri dish

m Cell phone camera

= Qptional: ruler

Software:

= iOS or Android camera app
= Optional: Lapselt

= FlJI

Troubleshooting

Safety warnings

© Use caution when working with glass Pasteur pipettes and sharp items like razor blades and scalpels and
dispose of these materials in the proper container.

Before start

Assemble and test the imaging chamber before starting an experiment.
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Assemble the imaging chamber

1 Cut all cardboard panels for the outside of the imaging chamber. You can use the *.dxf 30m
files with a laser cutter or Cricut cutter. If you are using a boxcutter or scissors, print out
the * pdf files, cut out the shapes, and use these to draw outlines on the cardboard to be

cut.

t

Figure 1. Cut out cardboard parts of imaging chamber. A. chamber walls, B. light panel
support, C. base, D. phone platform, E. lens support, F. lens spacer.

2 Glue the light panel support to the base, making sure it's centered. This creates the base 1m
assembly.
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Figure 2. Light panel support attached to base.

3 Optional: add four rubber bumpers to the corners of the base. This will keep the imaging
chamber from moving on the bench.

m

4 Glue the lens spacer to the phone platform centering the holes.
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Figure 4. Lens support attached to phone platform.

5 Position the lens inside of the lens spacer with the concave side facing away from the 1m
phone platform.

Figure 5. lens inserted in the spacer.
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Note

The recommended lenses are inexpensive and easy to purchase because they are mass
produced for VR goggles. The focal length is 45 mm and the diameter is 25 mm. If you are
using lenses with a different diameter, the size of the hole in the phone platform, lens
spacer and lens support will have to be adjusted. If you are using a lens with a different
focal length, the height of the walls will have to be adjusted.

6 Glue the lens support to the lens spacer, securing the lens between the lens support and 1m
the phone platform. Be careful not to get glue on the lens. This creates the phone
support assembly.

Figure 6. Lens attached to phone platform assembly.

7 Assemble the walls of the chamber. Make cuts halfway through one wall of the 3m
cardboard to fold the flaps to contact the long sides of the walls. This creates the
chamber walls assembly.
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Figure 7. Chamber walls assembly.

8 Cut the vinyl sheet to 84 mm X 100 mm and adhere to the LED light panel. You can use s
the lightpanel_film.svg file with a Cricut cutter.

Figure 8. Left: light panel with vinyl sheet attached. Right: light panel without vinyl sheet.
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Note

The A6 LED light panels recommended here were chosen because they are inexpensive
and do not heat up the sample during imaging. Because the LEDs are located to the side
of the panel there is a slight gradient of light intensity in the background (see example
data below). If you need uniform background illumination, consider a different light
source.

Image a sample

9 Place the light panel on the base assembly, connect the micro USB cable, and plug the 1m
cable into the wall adaptor. Turn on the light panel.

Figure 9. Light panel on base assembly.

10  Place the Hydra in a petri dish with Hydra medium and place the dish on light panel, then 5m
place the chamber wall assembly on the base assembly.
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Figure 10. Sample in imaging chamber.

1" Place the phone platform assembly on top of the chamber walls.

Figure 11. Assembled imaging chamber.

Note

For some experiments, you may want to let the Hydra acclimate to the new environment
before starting the recording.
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12 On your phone, open the camera app or Lapselt time-lapse app. With the phone's 2m
camera centered on the lens, move the phone platform until the sample is centered on
your phone's screen.

Figure 12. phone camera aligned with lens and centered on sample.

13 Set the desired time-lapse parameters on your phone and start the acquisition. The m
example movie below was acquired with the Lapselt app with 5 second interval for 30
minutes.
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Note

You can zoom in on your sample for acquisition, but keep in mind that images of the ruler
for setting the scale will need to be acquired with the same zoom settings.

I Import video into FIJI

14 The iPhone camera app exports time-lapse movies in *mov format and Lapselt exports
movies in *mov or *mp4 format. Follow these steps to import movies in these formats
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into FIJI.

15 Open FIJI. Go to the Help menu and select Update.

2m
Fili File FEdit Image Process Analyze Plugins Window Hi
® L) (Fiji Is Just) ImageJ
D_|Q C<|Q‘3|_/_A_t:+' ”\|A ,OlQ"l] )t Dev. | Stk ImageJ Website...
*Oval*, elliptical or brush selections (alt or long click to switch) Dev. Resources...
Macro Functions..
Examples
Update Image.J...
Release Notes...
Refresh Menus
About Plugins
About Imagel...
Report a Bug
Help on Menu Item
Update...
Uplzza Sample Image...
Figure 12. Help -> Update.

16 Add FFMPEG to the list of sites FIJI will download updates from. After the updater 1m
finishes running, click Manage Update Sites. From the list, check the box next to
FFMPEG, then Apply and Close.

Search:
Name Status/Action Update Site Ac.. Name URL Haost Di... Description
CSIM Laboratory hitps://sites imagej.net/. Aset of plugins, macros and scripts.
CWNS dense nuclei segme... https:/sites.imagej.net/. The Fiji implementation of the CWNS.
DeepClas4Bio-plugins https:/sites.imagej.net/... Collection of plugins that use DeepC.
DeaplmageJ hitps://sites.imagej.net... Bicimage processing using (pre-iral..
Dendrite Dynamics Tracker  hitps://sites.imagsj.net/... Dendrite-Dynamics-Tracker is a plug.
DHM Utilitles https://sites.image].net/... Collection of plugins for use In digital.
DiameterJ hitps://sites.imagej.net/... Macros for quantitative analysis of n..
DiversePathsJ hitps://sites.image}.net/... DiversePathsJ Implements a dynami,
DNA FISH hitps://sites.image].nev/... Plugin for semi-automated analysis ..
imagej.net/ Image registration using elastix
ELEPHANT https://sites.imagej.net/... ELEPHANT is a platform for 30 cell 1..
EM Tool hitps://sites.image].net/... EM tool is a suite of simple tools for ,
EpiGraph hittps://sites.imagej.net/... EpiGraph: an open-source method t..
EVAnalyzer https:/sites.imagej.net/e... EVAnalyzer EVAnalyzer is a Fill Imag..
Excel Functions hitps://aites.imagej.net/... “The Excel Functions and Excel Macr..
EZFig https://sites.imagej.net/... EZFig is a tool to build publication-re.
FAST hitps://sites. imagej.nelF... Fluorescence image AnalysiS Tool a..
ites imagej.net/F. . Fast4DReg is a Fiji macra for drift co.
(7 FFMPEG hitps:/Ajl.se/~schindelin... Fijl plugins which allow reading and .
Bl hitps://sites.image].net/F... Macros developed to measure the di
Manage Update Sites I Advanced Mods ply Char Ciose Add Unlisted Site ~ Flemovs Validate URLs || Apply and Close | |
Figure 13. Add FFMPEG to update sites list.
17 Close and restart FIJI. Go to the File menu. Select Import - Movie (FFMPEG). This option m

will only be available after FFMPEG is added to the list of update sites.
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| Edit Image Process Analyze Plugins Window Help

New Image Sequence... | (Fiji Is Just) ImageJ

Open... Raw... A ‘ﬁgﬁ-i i&ﬂ_‘

Open Next LUT...
Open Samples Text Image...

Open Recent Text File...

Import Results...

Show Folder Table...
URL...
Stack From List
TIFF Virtual Stack...
AVL...
XY Coordinates...

Close

Close All

Save

Save As

Revert
Movie (FFMPEG)...
Janelia H265 Reader
HDFS...

Export Analyze...
MHD/MHA...
Koala Binary...

Page Setup...
Print...

Quit

Fix Funny Filenames DF3...
Make Screencast FIB-SEM ...
MRC Leginon ...

Figure 14. Import your movie as FFMPEG.

18  Navigate to your movie file and click Open. m
Optional: calibrate distance
19 Take a picture of a ruler with millimeter scale using the same camera settings as your om

time-lapse acquisition. Import the image into FIJI.

20  Zoomin on a centimeter in the middle of the field of view. Use the line tool to measure 1m
the number of pixels in one centimeter. Draw the line from the center of one centimeter
line to the next.

21 Go to Analyze - Set Scale. The length in pixels of the line you drew should be filled in.
Change the Known Distance to 10 and the Unit of Length to mm. Check the Global box.
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09 Set Scale

Distance in pixels: [ 350.00

Known distance: 10 |
Pixel aspect ratio: | 1.0 |

Unit of length: mm

| Click to Remove Scale |
Global

Scale: 35 pixels/mm

|_ Help__|| Cance! || QK |

Figure 15. Setting a scale according to measured distance.

22 Open your time-lapse movie or image. The scale you set should be applied to the new m
image.

23 Optional: add a scale bar. Use the rectangle tool to draw a rectangle approximately
where you want the scale bar. Go to Edit - Selection = Specify. Check the Scaled Units
(mm) box, then adjust Width, Height and X and Y coordinates to have the scale bar with
the size and position that you want, then click OK.
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e e (Fiji Is Just) ImageJ
B ol ol /| <[zt~  Alo] o] 7 mffin] o] s o] |3
Fiji Is Just) Image) 2.14.0/1.54f; Java 1.8.0_322 [64-bit]; Click here to search

0ee Untitled (G) (50%)
28.57x28.57 mm (1000x1000); RGE; 3.8MB

® O ® Specify

Width: | 10
Height: | 0.5
X coordinate: 1

Y coordinate: | 1

" Oval

|| Constrain square/circle
|| Centered

Scaled units (mm)

Cancel = OK

Figure 16. Specify dimensions of the scale bar.

24 Use Ctrl + F to fill in the rectangle to create the scale bar. Colors for filled shapes can be

adjusted by going to Edit - Options - Colors.
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Figure 17. Scale baris 1 cm.
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